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Datafit is an an Engineering tool which is useful for generating functional equations and FFT calculations 
for tabular sampled data.    It allows the user to import the data from a file or enter it through a built in 
editor.    For curve fitting, Cubic Splines and Least Squares techniques are used. The equation coefficients 
and calculated vs. entered data can be displayed and printed in tabular format.    Statistics, such as 
correlation between entered and calculated data, are also calculated. Once equation coefficients are 
determined, the program can generate subroutine source code (Basic and C) which can readily be 
compiled and used to interpolate the data in user written programs.    FFT calculations can be done on the 
entered data directly, or can be first spline fitted to allow a faster sampling rate.    The FFT magnitude and 
phase calculations can also be displayed and printed in tabular format. In addition, output from this 
program for both the curve fitting functions and FFT calculations can be fed into Viewplot and the results 
can be viewed and compared graphically.

To learn how to use Help, press F1 or select Using Help from the Help Menu.
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Licenses and Registration

You are required to register your copy of DataFit and Viewplot if you find them useful.    A lot of hard work 
went into making them, and a lot more will go into making them better.    Payment of $30.00 for a single 
user license (based on US currency) can be accepted in the following forms:

1.    Cash
2.    Check/Money Order
3.    Credit Card (Visa, Mastercard, American Express)
4.    First Virtual
5.    Invoice

You may also obtain a Site license.    Site licenses cover a single organization for an area of up to one 
hundred miles (160 km) in radius.)    The cost of a site license is $100.00 (based on U.S. currency).

This payment will cover the use of both programs.    Once you are registered, you can obtain priority 
technical support, provide input for future releases, get rid of the nagging registration screens, receive 
upgrade information, and generally feel better about yourself.

To register, select Complete Registration Form from the Registration Information panel.    The 
Registration program will appear.    Follow the detailed instructions on the form.    Depending on your 
payment option, you will be given instructions on how to send the payment.    You only need to complete 
one registration form for both Datafit and Viewplot.    The Registration program can also be launched 
from the Register icon.

To register copies of Datafit/Viewplot please use the Register program provided with 
Datafit/Viewplot to make payments. We use KAGI Shareware registration service, which accepts different 
payment methods, including credit card and invoices. If you live in the US or Canada, you may also mail 
us your check or money order directly, payable to John A. Gilmore, at the following address:

Engineered Software
C/O John A. Gilmore
1315 Varner Road
Pittsburgh, PA 15227, USA

Once we receive the form, you will receive a confirmation letter which will include your registration 
number and license agreement.    Once you have received a registration number, you may permanently 
enter it by selecting Enter Registration from the registration information panel.    Be sure to enter your 
name EXACTLY how it is spelled on the confirmation letter. If you have any problems entering your 
registration number, please contact technical support.



Customizing Datafit

You can change some user preferences using the Options menu. Choose Edit - Options in the main 
Datafit window to access the following user preferences.    The changes are saved in the datafit.ini file in 
your Windows directory for future sessions. These preferences are:

1.    Window Settings

Font Setup:    Font, Fontsize and Fontbold are the font designations for window text.    Depending on the 
current window size and video driver in use, these settings can be changed to allow all window 
information to be non-overlapping and visible.    If buttons are overlapping (font too large), or the window 
text is difficult to read (font too small), these settings can be changed to any available screen font/size 
supported by your system.    To change the font designation, click the Change Font button, and select the 
desired font from the Font Dialog box.    During installation, Ms Sans Serif is designated as the default 
font.    This is a common Windows font.    If however, your system does not have this font, you will be 
warned and the default system font for your system will be used. If you receive this warning, you can 
correct the problem here.

Window Settings:.    The windows can be moved and resized once they are visible, but these setting 
determine their initial placement and size.    Default X is the designation for horizontal placement of the 
windows (in pixels).    Default Y of the designation for vertical placement of the windows (in pixels).    
Height is the window height (in pixels), and Width is, you guessed it, the window width.    To change these 
settings, enter the properties in the appropriate text boxes.    To make the windows appear full screen 
upon startup, click the Fill Display button.    This will set the default window size to be maximized to the 
screen dimensions designated by your current video driver. You can position and size the screen prior to 
selecting Edit - Options and click the Set to Current button to set the default window settings to the 
current settings.

Project Directory:    This is the directory where all of the projects are stored. When you install DataFit, 
you are prompted for the directory in which to install the executables. The default project directory will 
exist in the install directory and will be called projects.    If you want to change it, create a new directory 
(from DOS or Windows File Manager) and change the text in the Project Directory box to point to the 
new project directory.    If a project is currently opened when you go into the Options panel and the 
default project directory is changed, the new project directory will be saved, but will not be enforced for 
the current session.    If you want to change the project directory in mid-session, make sure you dont have 
a project currently opened when you enter the Options panel.

When you exit the Options panel by selecting the Ok button, the changes you made will be automatically 
saved.    If you want to exit the panel without changing any settings, just press the Cancel button.



Entering Notes

Project notes to identify projects can be entered and saved along with the project.    To enter notes in the 
Notes textbox, simply click on the box and type in the desired text. The notes will automatically be saved 
when the project is saved. The textbox has multiline cabability, and if more text exists than there is room 
to display it, scroll bars will appear on the right of the box. 



Entering the Data

To enter tabular data, choose Edit - Data from the main menu. This will bring you into the Data Entry 
Panel.    The data needs to be entered so that X is the independant variable, and Y is the dependant 
variable.    The equations generated will be of the form y = f(x).

There are two ways to enter the data once you are in the Data Entry panel.

1.    Choose Import from the File menu.    This will prompt you for a filename to import. The file structure 
needs to be two values per line (X Y) format but the data can be be comma delimited, tab delimited, or 
space delimited, or a combination of these.    For example: 

1.0,2.0 is valid (comma delimited)
1.0, 2.0 is valid (comma delimited with space)
1.0 2.0 is valid (tab delimited or multiple space delimited)
1.0, 2.0 is valid (comma delimited with multiple tabs or multiple spaces)
1.0 2.0 is valid (space delimited)

It is not necessary to know the file structure being imported, the software will automatically detect this.    
All leading and trailing spaces and tabs are ignored.    If you want to import data from another software 
package, like Excel, choose File - Save as... and select Comma, Tab, or Space delimited format from the 
Excel file menu.    If the independant and dependant values are switched (are of the format (Y, X), you 
can reverse this by choosing Data - Exchange from the menu.    This operation will exchange the X and Y 
values, making X = Y and Y = X.

2.    If the data is to be entered at runtime, just start typing the values in the X Value and Y Value text 
boxes. Initially, the X Value box will have focus.    Enter the X coordinate, press enter (or click in the Y 
coordinate box), then enter the Y coordinate.    Press enter again to accept the Y coordinate and also 
activate the Enter Points button (you can also click on the Enter Points button).    The (X, Y) data pair 
will be entered into the list. You may enter up to 1000 (X,Y) data pairs.

To insert data points, just enter them on to the list as described above.    The data will be appended to 
the end of the list, but will be sorted automatically according to the X Values when exiting the data 
entry panel.    The data can also be sorted at any time by choosing Data - Sort from the menu.

To edit points, click in the box containing the X,Y data on the pair you wish to edit.    The data selected 
will appear in their respective X and Y coordinate boxes, and Editing Points will appear in the list next 
to the line selected.You can then edit existing X and Y values as described above, except the currently 
selected data will be replaced with the new data.    If you decide not to change the currently points, just 
continue as if you are entering new points (you dont have to re-type the data) and the old values will 
be put back in place.    If you want to delete the currently selected points, choose Delete Points.

You can also export the data into a file by choosing Export... from the File menu.    You can export the 
files in comma delimited, space delimited or tab delimited format.    You will be prompted for a filename for 
which the file can later be imported, or read by another software package such as Microsoft Excel.    
Again, if the you accidentally entered the data so that the independant and dependant values are 
switched (are of the format (Y, X), you can reverse this by choosing Data - Exchange from the menu.    
This operation will exchange the X and Y values, making X = Y and Y = X.



Exporting Program Subroutines

Once solutions have been obtained for the various curve options, you have the capability of generating 
source code in the form of functions in order to incorporate them into other program source code. BASIC 
and C are currently supported, with future plans of adding PASCAL and FORTRAN (and any other user 
requested source codes).    Choose BASIC or C from the Export  menu in the main panel.    You will be 
shown a list of successfully solved equations and their corresponding correlation coefficient.    Once you 
select the desired equation from the list, you will be prompted for a function name.    This function name 
can be any syntactically correct BASIC or C function name. The function name syntax is not checked 
here.    You will then be prompted for a filename for which to save the function. 

How to use an exported function:

Two variable are passed to the function. The first variable is the X value you wish to have interpolated.    
The second variable is a boolean which the function sets to 1 if the function call is a success, or to a 0 if 
the function call fails.    The function call will return a failure if the X value passed to it lies outside of the 
range of input values.    Define the X value as double precision, and define the boolean variable as 
integer.    The function returns the interpolated Y value as double precision.    There is no other error 
checking in the function other than checking for the valid range.    The source code generated is also self 
documented.

1.    Exporting to BASIC example

Export a BASIC function called interpolate.    Paste the function into your code.    The calling routine the 
user creates should look like the following example:

Sub get_data ()

        Dim x_value As Double, y_value As Double
        Dim success As Integer

        x_value = 2.0
        y_value = interpolate(x_value, success)

        If success = 1 Then
print Y = ;y_value

        else
print Y was outside valid range

        endif

End Sub

2.    Exporting to C example

Export a C function called interpolate.    Paste the function into your code.    The calling routine the user 
creates should look like the following example:

#include <math.h>
#include <stdio.h>

void main()
{

double y_value;
double x_value;
int success;



y_value = interpolate(x_value, success);
if (success == 1)

printf ("Y = %e", y);
else

printf (Y was outside valid range);

}

Simple examples, but you get the idea.
Remember, the equation is valid ONLY within the range of input data.



FFT Calculations

FFT Calculations can be performed on a given set of input data.    The data is entered in the same 
manner used for curve fitting.    It is assumed that the X data contains the time intervals, and the Y data 
contains the real sampled data.    Once the data has been entered, select the FFT checkbox.    You must 
also select either the Use Input Data Only or the Use Spline Fitted Data option button.    You also need 
to select the Number of Samples used for the calculation by increasing or decreasing the value by 
clicking on the spin button.    You can also output the phase calculations in either Degrees or Radians by 
specifying your preference in the Output Units combo box.

There are two requirements of the FFT algorythm:

1.    The number of (X,Y) data points (samples) passed to the algorythm must be a power of 2.
2.    The data samples must be in equal time increments (see below).

The following scenerios will occur if you select Use Input Data Only:

The solver first checks to see in the X data is in equal increments.    If there are variations in the 
time intervals between data pairs, you will get an error message.    If the X data is not in equal 
increments, select Use Spline Fitted Data.

If the number of entered data points is smaller than the Number of Samples specified, the 
dataset will be zero padded up to the power of 2 specified in the Number of Samples textbox.    
The number of zeros appended to the data is shown in the Number of Zero Fills textbox.

If the number of entered data points is larger than the Number of Samples specified, the dataset 
will be truncated to the power of 2 specified in the Number of Samples textbox. The number of 
zeros appended to the data and shown in the Number of Zeros textbox will be 0.

The following scenerios will occur if you select Use Spline Fitted Data:

Prior to calling the FFT algorythm, the program will perform a Natural Cubic Spline on the entered 
data.    See Specifying Equation Types for information on Natural Cubic Splines.

The dataset will be spline fitted and sampled at equal intervals determined by the number 
specified in the Number of Samples textbox. The number of zeros appended to the data and 
shown in the Number of Zeros textbox will be 0.

When viewing the output, the Magnitude and Phase for each discreet frequency point will be displayed.    
The signal can be reconstructed from the FFT by the following method:

y(n) = [sum from k = 0 to N/2] {FFT magnitude * COS((k*2*pi*n/N) + FFT phase)}

where

N = Number of Samples
n = 0 to N-1



Managing Projects

All of the projects are saved in the directory specified in the Default Project Directory in the Options 
menu.    When you first install the software, the default project directory will be the directory where you 
installed the executable files for this software.    If you later want to change this default directory, you may 
change it by choosing File - Options in the main menu.

To create a new project, choose Projects from the main File menu.    The projects window will appear. A 
list of existing projects (there will be none at first) will appear in the list box.

Creating a New Project

To create a new project, choose New and enter the name of the new project in the dialog box.    You are 
limited to 8 characters (DOS) with no extensions.    The extention used for project directories is *.PJT.    
After entering the new project name and selecting OK, and the new project name will be added to the 
projects listbox. 

Opening a Project

To open a project, select the desired project by clicking on it in the project listbox, then choose Open.    
The project will be read and you will be returned to the main Datafit window. Only one project may be 
opened at a time. 

Deleting a Project

To delete projects, select a project in the project listbox and choose Delete.    You will be prompted for 
confirmation of the project deletion.    If you select OK, all files in the currently selected project directory 
along with the project directory itself will be deleted. 

Exiting the Project Window

Choosing Exit will hide the projects window and you will be returned to the main DataFit window.



Printing

You have the capability of printing all of the input and output data generated by the software. Once you 
have solved the projects, select Equations/Statistics or FFT Data from the View menu in the main 
panel.    See Viewing Output on how to use the View Equations/Statistics and FFT Data windows. 

Printing Equations and Statistics:

You can print the statistics for all of the equations by selecting Statistics from the Print menu.    To print 
equation coefficients or tabulated input and calculated data for a specific equation, select the desired 
equation by clicking on it and choose Coefficients or Data from the Print menu.    You have the option to 
print the data to a file by selecting the Print to File checkbox in the Print Dialog Box.    If you select Print 
to File, you will prompted for a filename.

Printing FFT Data:

The tabular FFT data can be printed in a similar manner.



Specifying Equation Types 

DataFit Solves for the following types of polynomial equations:

1.    Cubic Splines Method

Cubic Splines method calculates a connected group of third order polynomials which pass smoothly 
through each input data point.    There will be one cubic polynomial for each X interval of the input data. 
The form of the equation for the (i)th interval is:

F(x) = Ai+ Bi(X - Xi) + Ci(X - Xi)^2 + Di(X - Xi)^3 where Xi <= X <= Xi+1 

When viewing the ouput, the coefficients will appear as follows:

Cubic Splines Cnd. 1

Interval X = 1.0 to 2.0

X to the power 0 = 1.023
X to the power 1 = 3.442
X to the power 2 = 1.562
X to the power 3 = 1.222

Interval X = 2.0 to .......

To use the function for this interval, the following values can be assigned:

Xi = 1.0
Xi+1 = 2.0

If we want to interpolate the value X = 1.5:

1.0 <= 1.5 <= 2.0 is true. The equation then becomes:

F(x) = 1.023 + 3.442(1.5 - 1.0) + 1.562(1.5 - 1.0)^2 + 1.222(1.5 - 1.0)^3

See Exporting Program Subroutines to create functions in C or Basic to do this automatically.

Since the data passes through each data point, there is no deviation between the interpolated data and 
the input data.

The mathematics of the cubic splines method gives rise to alternatives at the end intervals of the curve.    
These conditions are:

a.    The end cubics approach linearity at their extremes.
b.    The end cubics approach parabola's at their extremes.
c.    The second derivitive of the slope of at the extremes approaches linearity.

The last method is called a natural spline, and is used most often.    The best method to use is probably 
when one knows the shape of the slope of the function at the endpoints, or at least make reasonable 
estimates of the slopes.    All three can be compared graphically using Viewplot and the best method 
selected.

2.    Least Squares Method 

This method attemps to fit a single function through the entire set of data points. Unlike the Cubic Splines 



Method, the curve is not guarenteed to pass through each data point.    This method derives a function 
such that the sum of the squares of the differences between the approximating function and the actual 
functional input values is minimized.

The form of the equation for an Nth order interpolating polynomial is:

F(x) = A0 + A1 * X + A2 * X^2 + .... + An * X^n

The highest order of the interpolating polynomial is N - 1, where N is the number of input data points.    As 
the order of the equation increases, the deviation between the interpolated data and the input data 
decreases until the degree of the approximating polynomial n reaches N - 1.      At this point, however, the 
approximating curve will loose it's "smoothness" between the data points.    Statistically speaking, the 
order of the approximating polynomial should be increased only to the point where there is significant 
decrease in variance between the calculated and input data sets.    These statistics can be observed in 
the View Equations/Statistics window.    You have the option of solving for a single order equation, or 
"sweeping" through multiple orders with the same input data set.    The highest order equation solved 
using Datafit is n = 20.

When viewing the ouput, the coefficients will appear as follows:

Least Squares Order 3

Interval X = 1.0 to 5.0

X to the power 0 = 1.023
X to the power 1 = 3.442
X to the power 2 = 1.562
X to the power 3 = 1.222

This single equation (a cubic in this example) is valid for the entire range of X values.    If we want to 
interpolate the value X = 1.5, the equation then becomes:

F(x) = 1.023 + 3.442(1.5) + 1.562(1.5)^2 + 1.222(1.5)^3

See Exporting Program Subroutines to create functions in C or Basic to do this automatically.

DataFit also solves for the following common functional forms using the Least Squares method:

1. Y = 1/(A+B*X)
2. Y = A+B*X+C/X
3. Y = A+B/X
4. Y =    X/(A*X+B)
5. Y =    A+B/X+C/(X*X)
6. Y =    A*X^B        
7. Y = A*B^X        
8. Y =    A*B^(1/X)        
9. Y =    A*X^(B*X)        
10. Y =    A*X^(B/X)
11. Y =    A*e^(B*X)        
12. Y =    A*e^(B/X) 
13. Y =    A+B*Ln(X)
14. Y =    1/(A+B*Ln(X))
15. Y =    A*B^X*X^C        
16. Y =    A*B^(1/X)*X^C        
17. Y =    A*e^(((X-B)^2)/C)        
18. Y =    A*e^(((Ln(X)-B)^2)/C)



19. Y =    A*X^B*(1-X)^C      
20. Y =    A*(X/B)^C*e(X/B)    
21. Y = 1/(A*(X+B))^2+C)

To view these functions while in the software, select the List Functions button in the main window.    A list 
box will appear with the above equations listed. 

Some of these forms are linearized by taking logarithms prior to solving with the least squares method.    
This being the case, the sum of the squares of the deviations from the actual data is minimized with 
respect to ln(F(x)) as opposed to F(x).    For cases which involve input data which contain zeros or 
negative numbers, the data set must be transformed to an equivalent set in which all values are positive. 
Only the equations that successfully solve will appear in the solution. Some of the equations require data 
in certain ranges (by the laws of mathematics) and may not appear as part of the solution. If a particular 
equation form you want to use is not showing up in the solution, check the range of input data and make 
sure that the equation you desire is feasible for the range. 

The use of these equations is a little more straightforward. When viewing the ouput, the coefficients will 
appear as follows:

Y=1/(A*X+B)

Interval X = 1.0 to 4.0

Coefficient A = 1.023
Coefficient B = 5.416
Coefficient C = 0.0

This single equation is valid for the entire range of X values.    If we want to interpolate the value X = 1.5, 
the equation then becomes:

F(x) = 1.0/(1.023 * 1.5 + 5.416)

See Exporting Program Subroutines to create functions in C or Basic to do this automatically.

To select any or all of the equation types, click in the check boxes next to the desired curve. 



Viewing Output

1.    View Equations/Statistics

From the main Datafit window, choose Equations/Statistics from the View menu.    There are three 
boxes on the panel. The uppermost box contains the successfully solved equation list as well as the 
correlation between input and calculated data.    Correlation is calculated in order to determine how well 
the approximation function describes the input data. A correlation of 1.0 indicates a perfect fit.    The 
approximating function is less accurate as the correlation decreases from a value of 1.0. To read more on 
how to interpret these values, see    Specifying Equation Types.

The equation coefficients appear in a listbox on the bottom left, while the tabulated (X,Y) data from the 
approximating equations appears on the bottom right.    If there is more output than there is room to 
display it, scroll bars will appear on the right of the list boxes.    If the text scrolls out to the right of the list 
boxes, you can pick a smaller font height and typeface by customizing the user preferences. To view the 
coefficients for the different equations, click on any equation in the list (or use the up/down arrows on the 
keyboard).    The currently selected equation will appear selected by being having asterisk markers next to 
it.    If more equations are present than can be listed, use the scroll bars on the right of the equation list to 
move through the list.

2.    View FFT Data

From the main Datafit window, choose FFT Data from the View menu.    The discreet frequency points 
along with the magnitude and phase components will be displayed. To read more on how to interpret 
these values, see    FFT Calculations.

3.    View Plots

From the Datafit main window, choose Equation Plots or FFT Plots from the View menu.    This will do 
one of two things.    If Viewplot is not already running, it will launch Viewplot, read the solution file and 
prompt you for equations or FFT data to load.    If Viewplot is already running, it will activate Viewplot, 
open a new plot window, read the solution file and prompt you for which equations or FFT data to load.    
For more information on how to use Viewplot, see the online help provided with Viewplot.

In order to launch Viewplot from Datafit, Viewplot must be registered.    If it is not, you will receive an error 
message telling you so.    Until you register Viewplot, you must run it from the icon.



Obtaining Technical Support
  
Shareware Evaluation Users

Questions will be addressed to the extent that answers are needed to determine whether or not 
Datafit/Viewplot will fit your needs.

You may obtain technical support in one of the following two ways:

1.    Questions by US Mail

Send your questions to:

Engineered Software 
C/O John A.Gilmore
1315 Varner Road
Pittsburgh, PA 15227

Be sure to include your return address.

2.    Questions by EMAIL

You can send Email via internet to johng@kagi.com.    Be sure to include your return address. This is 
probably the quickest way to obtain technical support.

Registered Users

In addition to the above two methods, you will receive phone support as well. Call (412) 881-4210 
between 9:00 AM and 3:00 PM Eastern Standard Time.    If there is no answer, please leave a message 
with your name, phone number and license number reported to you from the software.    You can get the 
license number by choosing About Datafit from the Help menu.    In the near future, there will be fax 
support as well.



Warranty Information

Limited Warranty:

a.    The licensor warrants that it has the right to license the use of the licensed product(s).

b.    The Licensor warrants that the licensed product(s) will substantially perform as described in the 
products documention, provided that the licensed product(s) is installed properly on an IBM 
compatable computer running an unmodified copy of Microsoft Windows, version 3.1 or greater.

c.    This limited warranty is in lieu of all other waranties, expressed or implied, including, without limitation, 
warranties of merchantability and fitness for a particular purpose.

Limitation of Liability:

a.    Licensees sole and exclusive remedy for damage or loss in any way connected with the Licensed 
Product(s) or any services furnished by or for the Licensor, whether by breach of contract, warranty, 
due care, or breach of any other duty, shall be, at the Licensors option, (I) replacement of the Licensed 
Product(s), (ii) reperformance of services, or (iii) return to Licensee of the License Fee if non-
performance is documented within ninety (90) days of the execution of the License Agreement.

b.    The Licensor shall not be liable to Licensee or to any other person for any special, incidental, indirect 
or consequential damages whatsoever even if the Licensor has been advised of the possibility of such 
damages, including without limitation, damages for loss of goodwill, loss of profits, business 
interruptionm and computer failure or malfunction.

DISCLAIMER

While Engineered Software has made every effort to deliver a high quality and useful product, we do no 
guarentee that this product is completly free from defects.    Engineered Software is not responsible for 
any damage to the purchasers computer system or data and in no event will Engineered Software, its 
officers, directors, employees or agents be responsible to the purchaser for any consequential, incidental, 
or indirect damages (including but not limited to damages for loss of business profits, business 
interruption, or loss of data) arising out of the use or inability to use the Engineered Software product, 
even if Engineered Software has been advised of the possibility of such damages. 



Additional Information

If there are enhancements you would like to see added to Datafit/Viewplot and are a registered user, 
please dont hesitate to let us know. You can contact us by any of the methods listed in the Technical 
Support information.    We cannot guarantee that every request will be honored, but well do our best.    
Nows the time to get your requests in. 

Also, If there is a specific application you need or would like to see, we are open for suggestions.    We 
have some other projects planned for the future, but would also like to hear from you.    This can even be 
Graphical Interfaces to code you may already have (for those of you in industry with all that Fortran 
source code lying around...)

Keep an eye on our Homepage on the Web.    The address is:

http://198.207.242.3/authors/johng/, or 
http://www.kagi.com/authors/johng/ 

Dont forget the trailing slash!

Updates to the programs will be listed there, as well as new programs in the works.    New versions can 
be downloaded from the Homepage.

Thanks:

Thanks to Chuck (did you put your drums together yet?) McGowan for his constant input and 
heckling during development of this program. 

Thanks to Jon (your kids are adorable) Gotow at St. Claire Software for helping us get the ball rolling.

Thanks to Adrian (swing and a miss!) Perregaux for his ideas, QA efforts and humor.

Thanks to Greg Kochaniak (http://198.207.242.3/authors/gregko/ or gregko@kagi.com) for writing the 
Register program, and Kagi Shareware (http://198.207.242.3/) for providing their service.

Also, Thanks to Honda Corporation for making such awesome, thought provoking, fast motorcycles.

Finally, and of ultimate importance, thanks to Nancy for being in my life.




